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Introduction 

 

 

 

Microsoft OneNote is a tool that you can use with a slate or convertible tablet or with a tablet mouse on 
a desktop or laptop computer. You can also use it with a keyboard. It lets you enter information using 
handwriting or the keyboard into what can be called a highly organized free form digital binder. 

There are several built-in accessibility features to OneNote. The most impressive is that keyboard 
commands are an item on the Help menu in OneNote 2007.  

 

Figure 1 Keyboard commands from the OneNote 2007 Help menu. 

When you first launch OneNote you’ll find a notebook opens that is a “how to use OneNote” guide that 
you will have access to at any time. 
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Figure 2 Built-in how to use OneNote guide notebook. 

The advantage to using OneNote for students with disabilities is that you can record lectures or 
meetings and, using the keyboard, make annotations at important points. This gives students using 
screen readers the ability to independently record and annotate lectures. 

For students who use screen magnification, lectures can be recorded, annotations can be inserted using 
either your handwriting or the keyboard and drawings can be added to the notes.  

Both MAGic from Freedom Scientific and ZoomText from AiSquared have problems when entering 
information using a digital pen. Both companies are aware of the problem but to date OneNote is not a 
priority for support. It is the same with screen readers, although Microsoft has built in the hooks for the 
adaptive technology there is no support for this application. Whatever works is inherent in the design of 
OneNote and not the adaptive technology. 

Magnifier works well if you need magnification support. There is a tip to using this tool on a Windows 
Vista or Windows XP system. Launch Magnifier first and change its docking position so that it sits at the 
top of your screen. Then turn on the Input Panel. This will let you view the magnified Input Panel 
without having your arm or hand get in the way. It will also let the Input Panel expand as you write in it 
in a more natural manner. Once the Input Panel is launched, you can launch the applications you want 
to use. It will take a bit of practice to use the Magnifier tool with handwriting or the on-screen keyboard 
as your view will move with the flow of your handwriting and movements across the on-screen 
keyboard. It is quite usable though and another tool you can choose from. 

In Windows 7 if you choose an Aero Theme you will be able to take advantage of the full screen or lens 
views of screen magnification. This does not work with current versions of adaptive technology as the 
Aero Themes use a newer model of accessibility. 

To activate Magnifier on a Windows Vista or Windows 7 system, press the Windows key to open the 
Start Menu and type “Magnifier” without the quotes. Once it is shown in the list of found items, press 
Enter on it to launch it. 
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Another tip for using magnifier on a tablet computer with the digital ink tool is to dock the Input Panel 
at the top of your screen. This alleviates a lot of the cognitive disconnect between the areas you are 
working on. Docking the Input Panel at the top of the screen also gives you more flexibility in entering 
information in one larger piece rather than smaller pieces of sentences and thoughts. 

OneNote uses the built-in microphone on the slate, or traditional laptop for recording. If you are in a 
classroom environment, you will want to look at investing in something like the Sony ECM F03 flat 
boundary effects microphone1. You will also need to sit close to the speaker so that the audio can be 
picked up. Some of the newer lecture halls like the ones at Northcentral Technical College in Wausau 
Wisconsin have built-in connections to the lecture sound system which means you don’t need a 
microphone, just the cables to connect your computer to the sound system. 

OneNote can be used as a stand-alone application on your computer. OneNote comes with the 
Microsoft Office Home/Student version and all other versions of Microsoft Office. Many people have 
OneNote and don’t know they do or don’t know what it is. 

This document will provide information on using OneNote on a slate, traditional laptop, and desktop 
computer.  

OneNote and People with Disabilities 
One of the advantages of using OneNote on a slate rather than a convertible or laptop computer is that 
you have more global access to the method of input you prefer according to your working environment 
or task. Using the Input Panel on a slate, you have the ability to switch between: 

• On-screen keyboard. 

• Speech Tool [limited voice recognition]. 

• External keyboard. 

• Handwriting. 

The slate gives you access to tools for tasks. You can also use any or all of these in OneNote. If you use 
the handwriting tool in Microsoft Office XP or later on a non-tablet operating system, your handwriting 
is automatically converted to text, not left as handwritten notes.  

Of course, you still have access to the Windows Text-to-Speech [TTS] tool, Narrator; and the screen 
magnification tool, Magnifier. Even if you don’t have the need for what is categorized as adaptive 
technology, these tools are ones you can use when you can’t see the screen the way you want, or if you 
are reading or proofreading documents and suffer from eye strain.  

We need to begin thinking of tools for tasks, not tools for disabilities. 

                                                           
1 Sony Boundary Effects Microphone: 
http://www.sonystyle.com/webapp/wcs/stores/servlet/ProductDisplay?catalogId=10551&storeId=10151&langId=-
1&partNumber=ECMF01&Dept=pa  

http://www.sonystyle.com/is-bin/INTERSHOP.enfinity/eCS/Store/en/-/USD/SY_DisplayProductInformation-Start;sid=QGZdnzg8Ee1dznk3rZpXlHctoZe2UPgTvIE=?ProductSKU=ECMF01&Dept=pa&CategoryName=pa_PADepartmentAccessories_Microphones_BusinessMics
http://www.sonystyle.com/is-bin/INTERSHOP.enfinity/eCS/Store/en/-/USD/SY_DisplayProductInformation-Start;sid=QGZdnzg8Ee1dznk3rZpXlHctoZe2UPgTvIE=?ProductSKU=ECMF01&Dept=pa&CategoryName=pa_PADepartmentAccessories_Microphones_BusinessMics
http://www.sonystyle.com/webapp/wcs/stores/servlet/ProductDisplay?catalogId=10551&storeId=10151&langId=-1&partNumber=ECMF01&Dept=pa
http://www.sonystyle.com/webapp/wcs/stores/servlet/ProductDisplay?catalogId=10551&storeId=10151&langId=-1&partNumber=ECMF01&Dept=pa
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Input Panel and Digital Ink 

 

 

 

On a tablet, there is an Input Panel that lets you change digital ink input modes on the fly as you need 
them.  This is typically found either next to the Start button or to the immediate left of the System Tray 
items on tablet computers. If you are using a laptop or desktop computer you do not have access to the 
Input Panel and will be using the keyboard to enter information or a tablet mouse. 

 

Figure 3 Input Panel button to the right of the Start button. 

By default, the Input Panel on-screen keyboard is available on computer start-up.  

Note: The Input Panel is not accessible by keyboard. You must use the mouse to 
work with it and adaptive technology doesn’t “see” it. If the Input Panel is visible, it 
is ignored by adaptive technology. 

You can still use standard methods of input such as a keyboard, alternate input device, voice 
recognition, or the Windows based on-screen keyboard. The Input Panel is strictly for use with the 
digital ink tools. 

 

Figure 4 Keyboard in Input Panel. 

You can minimize the Input Panel and use an external keyboard to enter information into the application 
if you want to. 
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Figure 5 Handwriting Input Panel option. 

The preceding image is from a help document on the Input Panel that was on the Microsoft web site for 
Windows XP. The page has since been retired. 

 

Figure 6 Input Panel options. 

The preceding image is from the article “Using Input Panel in Windows XP Tablet Pc Edition2.” 

The Input Panel tools are available while the Input Panel is minimized. The Following image from a 
Microsoft help document now retired shows how a small icon appears when you move the digital pen 
over an editable form area of an Outlook e-mail message. This icon also appears when you are in a 
browser such as Internet Explorer and hover over the Address Bar. 

                                                           
2 Using Input Panel in Windows XP Tablet PC Edition: 
http://www.microsoft.com/windowsxp/using/tabletpc/expert/vanwest_newtip.mspx  

http://www.microsoft.com/windowsxp/using/tabletpc/expert/vanwest_newtip.mspx
http://www.microsoft.com/windowsxp/using/tabletpc/expert/vanwest_newtip.mspx
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Figure 7 Image of Input Panel icon showing as the cursor/focus is in an e-mail edit field. Linked to web page article. 

The following images are from a Microsoft help document now retired and show the changes in the 
Input Panel when working in Outlook or Internet Explorer. In Outlook there are pre-defined entries 
common to e-mail messages while in Internet Explorer there are pre-defined entries common to web 
addresses. 

 

Figure 8 Input Panel Quick Keys for web browser article link. 
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Figure 9 Quick keys for e-mail on Input Panel. 

You can also use gestures in the Input Panel. Gestures are a type of shorthand for common tasks such as 
pressing the Enter key. 

 

Figure 10 Image of the gesture to insert a Tab Stop into a document. 

Handwriting 
Digital ink lets you enter your own handwriting into the computer and either keep it as your 
handwriting, or have it converted to text. This is not the Graffiti of PDA’s, this is your own handwriting. 
You can also use Gestures to perform activities such as Enter or Tab.  

 

Figure 11 Correction dialog open in the Input Panel. 
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If the word prediction tool indicates a misinterpretation of your handwriting you can either choose from 
a suggested list of words or make a correction. 

You can also use the digital pen to erase or scratch out words that might be unreadable or that aren’t 
what you wrote. Once you scratch out or erase the word it disappears from the prediction box in the 
Input Panel. 

 

Figure 12 Correct and edit text in the Input Panel. 

By using the word prediction tool you can adjust your handwriting or printing to lessen errors. It does 
tend to make you a neater writer. 

In OneNote, you can use your handwriting; have it converted to text, or draw diagrams directly into note 
containers/OneNote documents. The addition of digital ink technology allows you to search your 
handwriting for content. For example, you could have a combination of handwriting and text in a section 
and search for a work. OneNote would identify each instance of the word whether it was handwritten or 
text. 

You can also select handwritten content and convert it to text. This is mouse driven. Select a word or 
phrase that is handwritten. Press the right mouse button and choose “convert handwriting to text.” 

This is not a tool that is trained in the same way voice recognition is trained. There is a database of left 
and right handed writing samples that are compared to your individual style and interpreted. 

You have the option of using the Writing Pad which gives you some guiding lines on which to write, or 
the Write Anywhere option which lets you write anywhere on the page and that is where your 
handwriting is displayed.  The Writing Pad inserts your converted text at the current cursor point. You 
turn on automatic recognition in the Tools > Options > Handwriting category. Automatic recognition is 
turned on by default.  
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Figure 13 Karen's handwriting in the Input Panel. 

If you are using a non-tablet version of the Windows XP operating system, your handwriting will 
automatically be converted. This is because you don’t have the digital ink technology as a component of 
your operating system. 

Other Input Methods 
You don’t have to use the digital ink technology on a tablet computer. You can use your adaptive 
technology which works just fine (with the exception of MAGic which does not work on tablet 
computers at all). One of the nifty things about the digital in is that you can use it in combination with 
tools such as Narrator, Magnifier or even to some extent the JAWS screen reader. 

Narrator  
You have access to the narrator Text-to-Speech tool on a tablet computer. This tool lets you read 
documents and access most of the elements of your computer with audio feedback. If you are reading a 
long document and your eyes get tired, if you’re proofreading, or if you are in an environment where 
you can’t see the screen easily, this is a useful tool and access method. 

To launch Narrator on a Windows Vista or Windows 7 computer press the Windows key and type 
“Narrator” in the edit field without the quotes. Once you see Narrator in the list of found items, press 
Enter on it to launch it. Keep in mind that it is a TTS or Text-to Speech tool and not a fully functioning 
screen reader. 

Magnifier 
Magnifier is another tool you have access to. This will magnify part of the screen in a narrow band at the 
top of your screen. This is helpful for those documents in tiny fonts that you can’t adjust, proofreading 
documents with accents or symbols that may not be clear, or in environments where you may not be 
able to see the screen clearly. 

You can find Magnifier by pressing the Windows key in Windows Vista or Windows 7 and typing 
“Magnifier” without the quotes. Once you see it in the list of found items, press Enter on it to open it. If 
you are using Windows 7 and have an Aero Theme in chosen you can use Magnifier in full screen or lens 
view rather than the split view. 
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On-Screen Keyboard  
On a tablet computer, the on-screen keyboard in the Input Panel is the default input method.  

Windows does have a built-in on-screen keyboard. This is not the same as the keyboard on the Input 
Panel. 

To use the Windows on-screen keyboard press the Windows key and type “on-screen keyboard” 
without the quotes into the edit field in Windows Vista or windows 7. When you see the on-screen 
keyboard item in the found items list, press Enter on it to launch it. 

External Keyboard  
I recommend Motion Computing tablet computers3. They are durable and flexible. This is a slate 
configuration. The external keyboard with the Motion Computing slate is lightweight and usable by 
those of us with large fingers. It is not a compact or reduced in size keyboard and has most its keys in 
places we are familiar with. It is a USB keyboard although the slate is Bluetooth enabled so you can use 
wireless or Bluetooth technology with it. The bundle included the USB keyboard which works well. 

Speech Recognition 
The speech recognition tool in Vista and Windows 7 has improved greatly since the Windows XP 
operating system. It is a more global tool and works best with a USB headset. 

There is a short training process you go through and then you can use speech recognition to enter 
information into OneNote and other applications. 

If you are using Dragon NaturallySpeaking you will need to create macros that correspond to the 
keyboard commands for working in OneNote. I’ve done this and it is a great way to learn how to create 
DNS macros for an unsupported application. 

On a tablet computer, speech recognition includes sounds to let you know when recognition is finished 
as well as sounds associated with changes from dictation to voice command mode and other audio 
clues. In environments where you can’t clearly see the screen, these sounds are quite helpful in 
orienting you to what I happening as you dictate. Generally, these sounds aren’t picked up by the 
speech tool. 

Another environment where you would want the microphone and the speakers or output to be different 
is when you are listening to a screen reader or TTS tool and recording a meeting or lecture. This will let 
you annotate your audio file as you go.  

                                                           
3 Motion Computing tablet computers: http://www.motioncomputing.com/index.asp  

http://www.motioncomputing.com/index.asp
http://www.motioncomputing.com/index.asp
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OneNote Organizational Structure 

 

 

 

Now that we’ve explored the advantages of digital ink and a tablet computer, let’s turn to Microsoft 
OneNote which can be used quite effectively from the keyboard. 

In OneNote 2007 the menu bar is along the top of the application window, the Navigation Pane is down 
the left side of the currently open notebook and section, the currently open notebook and section are in 
the centre of the screen,  and the tabs for the pages and sub-pages are down the right side of the 
currently open notebook and section. Use F6 and Shift + F6 to move forward and backward through 
these components. There are keyboard commands for moving through the notebooks and sections 
down the left side of the document and keyboard commands for moving through pages and sub-pages. 
They are provided in this book as we come across the specific topics. 

 

Figure 14 Scanned and searchable text in OneNote 2007. 

When you first open OneNote, you will see the OneNote user guide notebook. This has helpful tips and 
techniques for using OneNote. The instructions are mouse dependent but will give you some good ideas. 

The hierarchy of OneNote content is as follows: 

• Notebook 

• Section. 

• Page. 

• Sub-Page. 

• Note Containers. 
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For example, you can have a notebook called History, and a section called Ancient. In the Ancient 
section, you can have pages for each week of the course and under each page which might represent a 
week; you can have several sub-pages of notes which are held in note containers. The notebooks, 
sections and pages can have names, but the sub-pages don’t. Sub-pages are organized in descending 
order of their creation under each page. When you move to a sub-page, the header of the page remains, 
but you have new writing space, or sub-pages. 

You need to have at least one section in a notebook or you will see the message in the middle of the 
page saying there are no sections in the current notebook and to click anywhere to open a section. 
Sometimes when you create a notebook a section is automatically added. 

OneNote Notebooks 
OneNote Notebooks is your root folder for OneNote 2007. OneNote creates this automatically when 
installed. Your notebooks are found within this folder. It is a good idea to begin organizing your OneNote 
information in notebooks. This helps you find related information quickly. 

Press Alt + F for the File menu then N for New and choose Notebook.  

 

Figure 15 Create a new notebook in OneNote 2007. 

This opens a Notebook Wizard which will guide you through the creation of your new notebook. 
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Figure 16 Notebook Wizard in OneNote 2007. 

Once you’ve created a notebook it is easy to find in the Navigation pane. To move to the new notebook, 
press Ctrl + G which moves focus to the Navigation Pane and the list of notebooks and sections.  Use the 
Tab key to move from notebook to notebook and the up and down arrows to find a section in a 
notebook.  Note that if you are using a screen reader, you are not selecting these items; you are merely 
taking focus to them. Select the folder or section you want by pressing the Spacebar to move to it.  Once 
a notebook is selected, it is opened and ready to work with. 

To move through notebooks while in the Navigation Pane [after pressing Ctrl + G.]: 

1. Press Tab or Shift + Tab to move among the list of notebooks. 
2. Use the Up or Down Arrows to move through the sections within a notebook. 

While looking through Sections using the Arrow keys, your cursor will not move to another notebook 
until you press the Tab key. 

Notebooks have sections which are “secondary level containers” for organizing your notes. 

 

Figure 17 Notebook and Sections identified in OneNote 2007. 
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Visually, there is the name of the notebook to the left of the sections in the notebook in OneNote 2007. 
The sections appear in the order in which you create them.   

If you go to the OneNote Notebook or the My Notebook  folder on your hard drive and look at the files 
you find there, you will see that each notebook is an “OneNote file.” If you have linked any documents 
to an OneNote document, a copy of them is also stored in the OneNote Notebooks folder. This is why it 
is important to begin thinking of how you organize your notes.  

If you decide to create notebooks after you’ve created sections, you will need to move all associated 
content to the new folder. This includes any audio files you’ve recorded with meetings and lectures. 
Audio files recorded using OneNote are identified as Windows Media files by default.  

Renaming Notebooks 
To rename a notebook make sure it is selected in the Navigation Pane, press the AppKey and choose 
Rename. 

 

Figure 18 Context menu in Navigation Pane showing Rename option. 

Deleting Notebooks, Side Note, Sections, Pages and Sub-Pages 
You can delete a notebook, section, page, sub-page or side note in OneNote. 

To delete a side note or notebook press Ctrl + G to open or put focus on the Navigation Pane and go to 
the side note or notebook you want to delete, press the AppKey and choose Delete. 

To delete a section, press Ctrl + Shift + G and use the Arrow keys to find the Section you want to delete if 
it is in the open notebook. If it is the Section you are in, press the AppKey and choose Delete. You can 
also delete Sections by pressing Ctrl + G and locating the Section in the Navigation Pane, pressing the 
AppKey and choosing Delete. 

You can’t delete a section without deleting all of the Pages or Sub-Pages in that section. 



21 
 

If you delete a notebook from My Documents, OneNote Notebooks it will also be deleted. 

To delete a page or sub-page– press Ctrl + Shift + A, then press the Delete key; or once the page is 
selected, press the AppKey and choose Delete. 

To delete using the mouse, Right Click on the Side Note or any section or folder title. Choose Delete. To 
delete pages or sub-pages, Right Click on any page or sub-page and choose Delete. 

Sharing Notebooks and Sections 
You can easily copy and paste notebooks and sections from one computer to another. Make sure that if 
you have any associated content or files, they are copied as well. OneNote can be set up on a network 
so that staff can share notes they’ve created. For students, one student can take notes during project 
meetings and then share them with other group members. For students with disabilities who are using 
transcribers, the lecture notes can be copied to a pen drive or flash card, CD or floppy disk [if there is no 
audio file or associated content] and used by the student on their own computer. There are details on 
this tool later in this book. Shared sessions in OneNote 2007 have been replaced by cloud based 
applications in OneNote 2010. 

Sections 
Under the notebook levels are your sections. If you think of notebooks as binders, then your sections 
will be individual “books” within the binder.  

You don’t need to have individual notebooks to create sections. You can keep them all in the OneNote 
Notebooks folder although if you are taking and keeping a lot of notes, this can get quite messy and 
chaotic. 

To create a new Section using the keyboard in OneNote 2007 press Alt + F, S. 

 

Figure 19 Create new OneNote 2007 Section. 

This will create a new section immediately after the current one. You will be in the edit area to title the 
section. Once you have typed in a title for the section, press the Enter key which will move you to the 
edit box where you can give the first page a name or title. 
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You can press Alt + N, S to add a new Section which will accomplish the same thing. 

 

Figure 20 New Section allowing edit of Section name. 

The OneNote section based keyboard commands: 

• Ctrl + Alt + Shift + letter O will open a new section. 

• Ctrl + Tab will move you to the next section. 

• Ctrl + Shift + Tab will move you to the previous section. 

Renaming Sections 
In OneNote 2007 the process for renaming a section is a bit convoluted. Press F6 until you are in the 
search edit box and then press Shift + Tab to move to the section closest to the search edit box. Use the 
Left and Right Arrow keys to move among the sections until you find the one you want to rename. Press 
the AppKey and choose Rename. It is easier to rename sections in OneNote 2007 in the Navigation Pane 
than from the main document area. 

 

Figure 21 Context menu with Section Rename option in OneNote. 

Sections have pages and sub-pages. The pages and sub –pages are where you enter, copy or paste 
information. 
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Moving Sections 
You can move Sections around if needed. If you’ve worked in Excel and rearranged worksheets, the 
process is similar. To rearrange the sections using the keyboard put focus on the section tab you want to 
move and press the AppKey. Choose Move from the context menu which will open a dialog with all of 
the notebooks visible.  

 

Figure 22 Context menu for moving a Section. 

Once you choose to move a Section another dialog opens with the options for moving the Section. 
Choose the notebook where you want the section to be moved to and Tab to the Move Before or Move 
After button to place it in a specific place in the notebook. 

 

Figure 23 Move Section dialog. 
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Pages and Sub-Pages 
Pages and Sub-Pages are where your work is done and stored. Content on a page can include hand 
drawn diagrams, text, handwriting, links to files, links to URL’s, information copied from web pages, 
images or audio files of lectures or meetings you’ve recorded. 

By default, each section has one page which will have your focus once you enter a name for the page, 
and markers along the right hand side that let you ad pages and sub-pages by clicking on them.  

 

Figure 24 Notebook Section with Pages and Sub-Page. 

The keyboard commands for adding Pages or Sub-Pages are: 

• Ctrl + N to add a new Page at the end of the current set of pages. 

• Ctrl + Shift + N in OneNote 2007 to add a new Sub-Page to the current Page or sub-page. 

In OneNote 2007 there isn’t a keyboard command to add a new Page in the midst of other Pages. 
However you can move Pages up or down in the list of pages. 

To move Pages or sub-Pages using the keyboard: 

• Alt + Shift + Up Arrow moves the selected Page Up. 

• Alt + Shift + Down Arrow moves the selected page down. 

Note: If you are using adaptive technology such as the JAWS screen reader you may 
need to use the Pass Through keyboard command [JawsKey + Number Row 3] in 
order to use these commands. These two commands may be used by your adaptive 
technology for another function. 

You don’t have to save side notes, sections, pages or sub-pages in OneNote; they are saved 
automatically when you close the application. However if you are in the habit of saving documents, Ctrl 
+ S will save your work as you go. 
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Page Headers 
Pages have headers that contain the name or title of the page, the day it was created and the time it 
was created.  

Press Ctrl + T to move focus to the Title edit area and select its contents. This is not a toggle. The entire 
text in the page header is elected. Press the Home key to remove selection or simply type the new page 
title/header information. 

 

Figure 25 Notebook and sections identified in OneNote 2007. 

The date and time in the header area of a page can be changed by selecting it and pressing the Enter 
key. Pressing the AppKey in this case will give you different options. There is a date navigator for 
changing the date and while the numbers for the days of the months are accessible, the area where the 
name of the month is currently not supported by adaptive technology. 

There are keyboard commands for inserting the date and time or sub-page: 

• Press Alt + Shift + D to insert the current date. 

• Press Alt + Shift + F to insert the current date and time. 

• Press Alt + Shift + T to insert the current time. 

These keyboard commands can be used anywhere on a page or sub-page. 

Side note Pages don’t have headers. 

Inserting Extra Writing Space 
OneNote may look like a traditional notebook, but it is computer-based. This means that it can behave 
in a way that is different from a traditional notebook. One of the differences is in setting up printing 
options so that your customized notes are printed in a readable and reasonable format. We will look at 
printing later in this document. One of the other “wow, do I need that” tools is the ability to add extra 
writing space anywhere on a page or sub-page. You can extend pages if you are writing a lot on one 
topic and want it kept all together. You can also insert extra space between text fields or note 
containers.  
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Figure 26 Adding extra writing space on a page or sub-page. 

For example, if you are in a meeting or lecture, and the person talking suddenly remembers something 
associated with a point they made five or ten minutes ago, you may look at a piece of paper and wonder 
where you are going to put that information so that it is contextually situated – related to the original 
topic. In OneNote, you can easily insert the extra space you need and add the associated content. 

From the keyboard, press Alt + the letter I for Insert, then N for Insert Writing space. Your cursor 
changes to a line with an arrow on either side, one pointing up or one pointing down. Using your up or 
down arrow, position your cursor where you want the white space to begin and press the Enter key. 
Press the Down Arrow until you feel you have enough extra writing space and then press the Enter key 
again. This will automatically insert the specified amount of white space. Note that OneNote has some 
predetermined increments of extra space so you can’t go on into infinity. 

 

Figure 27 Add extra writing space in OneNote 2007. 
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Using the mouse, click on Insert and then Extra Writing Space. Once you’ve clicked on this item and 
move your pointer onto a page or sub-page, the pointer looks like the image on the icon.  Click where 
you want the extra space to begin, hold down the left mouse button and drag the mouse pointer down 
to where you want the extra space to end. Once you have enough extra space let go of the mouse 
button. 

Whether you use the keyboard or the mouse, you can’t remove extra space once it is inserted. 

Selecting Pages and Sub-Pages. 
You can select pages and sub-pages and move or delete them. 

From the keyboard, press Ctrl + Shift + A to select the current page or sub-page. You can press Ctrl + A to 
select the page and sub-pages in a group. For example, if your focus is on a sub-page of Week One and 
you press Ctrl + Shift + A, this will select that sub-page. Pressing Ctrl + A with that one sub-page selected, 
will select the page Week One and all of its sub-pages. 

Pressing Ctrl + A while in a text edit area will select all the text in that edit area. You will need to 
continue pressing Ctrl + A to begin selecting incrementally, note containers, page and sub-page 
respectively. Whereas Ctrl + Shift + A will automatically select the current page. 

Note Containers 
Note containers are the smallest containers in the OneNote organizational structure. Note containers up 
here on pages or sub-pages and contain any type of content. Content includes text, handwriting, 
external audio files, multimedia, images, or links to files or web addresses.  

Note containers don’t behave in the same way that you organize information in a word processor or 
other application. These containers can be anywhere on the page. You can organize them all in a linear 
fashion, so that they line up along the left margin, but you don’t have to. They can also be different 
sizes. For those of you using adaptive technology, this means further organization skills. You will need to 
keep track of content locations for notes you create. Fortunately, this is relatively easy. 

There is a method of navigating between note containers on pages: 

1. With focus in a note container press Ctrl + A until the note container is completely selected. 
2. Press Tab to move to the next note container. 
3. Press Shift + Tab to move to the previous note container. 
4. When you have focus on the note container you want to work with, press the Home key to 

remove selection and place the cursor at the beginning of the first line. 

If you have done any work with PowerPoint the process is similar to navigating between placeholders on 
a slide. The difference is that pressing Escape removes selection and places the cursor at the end of text 
in a note container and pressing Enter which would put you into edit mode in PowerPoint, inserts a 
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blank line will also put your cursor at the end of text in a note container. If an image or file is selected a 
blank line will be inserted just after the container with the attached file, scanned printout or image. 

A note container can contain paragraphs, lines, lists, and other formatted text, except heading titles. We 
can think of each note container as a small document. If you are annotating an audio file as you go, you 
need to put each annotation into a separate note container. You move to a new note container by 
pressing the Down Arrow on the last line of text in the current note container. 

It is a good habit to get into pressing the Home key on that last line of text before moving to the next 
container. When we look at stationary, we will see that doing this before leaving the current note 
container helps focus your insertion point off of any stationary being used. 

When you press the Down Arrow, you are moved down one pre-determined increment of space on a 
page or sub-page. In OneNote 2007, if you don’t press the Home key at some point, either before or 
after you leave the current note container, the next note or image container will be placed immediately 
under the last character of the current note container.   

If you are using a mouse, simply click near the left margin to move your cursor point to the left margin. 
As a free form writing tool, clicking anywhere on the page will put the insertion point at that place on 
the page. 

Since you can have text or diagrams or other information placed anywhere on a page or sub-page, it is 
important for people using screen readers or screen magnification and OneNote 2007 to remember to 
press the Home key when they move out of one note container to create another. Pressing the Home 
key will move your insertion point to the left margin. If you don’t do this, your information will be 
scattered all over a page or sub-page, and you will have no contextual reference of the size and location 
of note containers. You use the Up or Down Arrow to move in and out of note containers and object or 
image containers. Having them scattered over pages and sub-pages can become problematic when 
reviewing notes You can use the technique for tabbing from note container to note container to find 
specific content however, for those of us using screen readers, it becomes “natural” to just put 
everything at the left margin. 

You can move around note containers using the standard Windows keyboard commands such as Ctrl + 
Left or Right Arrow to move word by word, Left or Right Arrow to move character by character, and 
Ctrl + Up or Down Arrow to move among the paragraphs within a note container. If you’re using a 
mouse, you can also use typical mouse clicks to accomplish this. There are keyboard commands that let 
you move among note containers and they are listed in the section above. 

When you are adding content, each piece of content may have its own container. If it is text or 
handwriting [handwriting on a tablet operating system], it is a note container that has a slightly shaded 
background and a bar along the top with which to size it horizontally. Handwriting on a non-tablet 
operating system is converted to text. If it is a photo or image, the container looks like a dotted line 
around the image with handles for resizing. 
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You can Select and move containers using the keyboard or the mouse. If you are a screen reader user, 
there is no indication that one note container is on top of another so good organization is even more 
important. 

Selecting, Moving and Resizing Note Containers 
To select a note container from the keyboard, press Ctrl + A while in the container. This will initially 
select the current line or a portion of the text.  

If you are using JAWS, it will say “outline item open” when you press Ctrl + A the first time and the line 
at the cursor point in the note container is selected. Pressing Ctrl + A again will select the Note container 
and JAWS will say “outline tree view, to move through or expand items press the Arrow keys.” This is a 
false report by JAWS since pressing Arrow keys will remove selection from the note container. 

Once a note container is selected, press the AppKey and you can choose to Move or resize the note 
container. If you choose resize, you will be returned to the container and focus will be on the handle in 
the middle right side of the container. Pressing the Right Arrow will expand the container to the right. 
Note that if you don’t have enough text to go to the right margin, once you press Escape to get out of 
resize mode, the container will snap to the size of the content.  

If you choose move, you can move the container using the Up, Down, Left or right Arrows. Once you get 
it positioned where you want, press the Enter key to anchor it. If you press Escape, the container will 
snap to its original location. 

You can resize or move an image by simply landing on the photo or image. This automatically selects it. 
Press the AppKey and choose Resize. Use the same keystrokes as above to resize the image. If you press 
the Right Arrow, you will increase the size horizontally, and then use the Down Arrow to resize vertically. 
You can alternate using the arrows to get the size you want. Press the Escape key once you’ve finished 
and your image is resized. 

If you are using the mouse, you can left click on handles and resize images. For containers, once you 
move your mouse pointer over a note container, you will see the small graphic to the left and the 
container sizing bar at the top. If you click on the resizing bar, you will select the container. Then you can 
move it to the location you want. To resize it, hold down the left mouse button on the left/right arrow in 
the upper right corner of the container and drag it toward the right. As with using the keyboard, if your 
text doesn’t span the entire line, once you release the container resizing bar, it will snap to the content. 

Side Notes 
This tool perplexed me for the longest time. At first I thought that if I created one while in Microsoft 
Word 2007, it would somehow be associated with my document so I could make notes about editing, 
contacts related to the document. I thought that if I opened a side note or the assumed associated 
document, both would be open and available for use. This is not true. 
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This is what I know about side notes. They are a separate section in OneNote and any side note you 
create [Windows key + N from the desktop] will be a page in the Side Notes section.  

You can change the colour of the side note section. The default stationary or page colour is yellow 
although you can change this. Each time you press Ctrl + N, you create a new page in the side notes 
section. If you are using a mouse, there is an icon in the System Tray you click on. Whatever the first line 
of text is in a side note, is the title or name that appears on the page tab in the right margin area of the 
document Window. You can do anything in a side note that you can do in a regular section page or 
subpage. You can view any side notes in OneNote.  

 

Figure 28 Side note on the desktop. 

Side notes have no header.  

If you access a new side note from the System Tray icon or by using Windows key  + N from the desktop, 
a small sticky note size Window will open and your focus will be on the first line where you can begin 
typing. You can also record a side note and the controls are on the bottom of the side note Window. 

If you are using a tablet computer, this is a good alternative to the sticky Notes included in the operating 
system, which are not completely accessible using the keyboard.  
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OneNote Tools 

 

 

 

This section of the book is a collection of the tools you have available in OneNote including the ability to 
search for items in both handwritten and typed form, zooming in and out of a page, and getting help. 

Zoom Tool 
As well as using Magnifier, OneNote has its own Zoom tool. Since OneNote is meant to be primarily 
digital, using larger fonts isn’t as much of an issue as it is with word processing documents.  You may 
want to use a combination of larger fonts and zoom to get a view that works for you. Of course, zoom 
will only magnify the documents, not the toolbar, menu items or dialogs. For these components, you will 
need to use Magnifier. 

• To zoom out press Ctrl + Alt + the Minus Sign [on the NumPad].  

• To zoom in press Ctrl + Alt + the Plus Sign [on the NumPad]. 

Note: If you are using the NumPad to control adaptive technology, you will need to 
turn the NumLock on to do this. 

OneNote Panes 
Almost everything in OneNote 2007 is done through a Pane. This includes bulleted and numbered lists, 
spell checking your work, and the selection of fonts.  

In OneNote 2007, Ctrl + F1 will show or hide any Panes that may be visible. Pressing this key 
combination when there is no Pane visible will show you the last Pane you used. 

Pressing F7 opens the spell check pane.  

Use F6 to move from the OneNote document to the pane and Shift + F6 to move back to the OneNote 
document. 

You can use Tab and Shift + Tab to move forward and backward through items in a pane.  

In the following image showing the Templates pane, use the Arrow keys to move through the individual 
Templates available to you. Use the Left and Right Arrows to expand or collapse the categories to see 
the individual templates. 
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Figure 29 Templates Pane in OneNote. 

Note: Not all Pane items or “controls” are arranged in a logical order for keyboard 
access. Since there are no shortcut keys or keyboard commands for the buttons, you 
may end up having to Tab or Shift + Tab several times to find the button or option 
you want. If you have RSI or repetitive stress injury to your wrists or arms, using the 
keyboard may not be viable in a Pane. You may have to switch to the pen or on-
screen keyboard. If you are a screen reader user with RSI, you may need assistance 
in using Pane controls. 
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OneNote Help 
The fastest way to get Help in OneNote is to press F1.  

The Help Window will open and your focus is in the “type in text” edit box. Once you type in the item 
you are searching for, press Enter. Once the results are shown you can get a list of links if you are using a 
screen reader or screen magnification that has this type of tool. 

The Help system in OneNote can be used with standard keyboard commands for working with Office 
Help documentation. 

Pressing Alt + F4 will close the Help Window. 

Finding Content 
It is easy to find information in OneNote. One of the powerful tools available to you on a tablet 
operating system is the ability to search your own handwriting for content. OneNote will search both 
handwriting and text entries for the criteria you identify. 

The following two images are from OneNote 2003 when I had a tablet computer and I thought they 
were worth including in this book as a demonstration of the flexibility of digital ink and tablet 
computers. 

 

Figure 30 The word navigation found in both text and handwriting. 

When used on a tablet computer landscape orientation, the page List Pane adjusts to the screen 
orientation. 

 

Figure 31 List of found items in a view summary format. 
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To start finding content in OneNote 2007, press Ctrl + F to move to the Find edit box. You could also 
press F6. F6 will toggle you through the main document Window, any Task Pane that is open and the 
find edit box. Type in the word or phrase you want to find and press Enter. If you are using a screen 
reader, you do not need to turn on forms mode. 

When you press enter, the instances of the search criteria are highlighted in the pages and sub-pages of 
a section. You look for information in sections by default. Press F6 to move into the main document 
Window and then press Ctrl + Page Up or Down to move through the iterations of your text in the entire 
section. Note that when in find mode, you can’t use Ctrl + Page Up or Down to move through pages and 
sub-pages. Exit Find mode by pressing the Escape key. 

If you are using the JAWS screen reader and want to review these found items in a list it is more 
awkward to do this in OneNote 2007 than in OneNote 2003 or 2010.  You have to route the JAWS Cursor 
to the PC Cursor and then move up to the line on the screen with the Section information. Use the Right 
Arrow key to move to the far right of the line until you hear Page X of Y which will be followed by “View 
List.” Use the Right Mouse Click equivalent to show the list. 

 

Figure 32 Found items listed in Pane in OneNote 2007. 

You could also press Ctrl + F1 once you’ve searched for something in OneNote 2007 and then open the 
Page List. To open the Page List, put focus on the Pane that opens by pressing F6, press Ctrl + Spacebar 
to open the context menu which has the list of available Panes and choose Page List. JAWS is able to 
move through the higher levels of found items but not the individual ones. This is a decrease in access 
from OneNote 2003 when JAWS would read all elements of the Page List Pane. This is a JAWS issue 
rather than a OneNote issue. 

In OneNote, while the page List or Search Results Panes are open you can’t use Ctrl + Page Up or Down 
to move through Pages or Sub-Pages. Close the Page List or Search Results Pane to use these keyboard 
commands to move through Pages and Sub-Pages again. 
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Section Colours 
You can quickly change the colour of a section in OneNote by pressing Alt + the letter O for Format, then 
C for Section Colour.  Your options are: blue, yellow, green, red, purple, orange, cyan, magenta or none. 
This only affects the current section. Typically the section colours cycle through all available colours. 

 

Figure 33 Change notebook colour dialog. 

In the preceding image the colour palette is open to show the possible colour choices for notebooks.  

Templates 
You can use templates for your notes. OneNote comes with several categories of templates to choose 
from.  There are also many templates online on the Microsoft web site. 

In OneNote 2007, to review the templates available press either: 

• Alt + F, N and choose Page from Template. 

• Alt + letter O and choose Template. 

Both of these will insert a new page with the template you choose.  

When you press either of these keyboard commands the Templates Pane opens and you can use the 
Left or Right Arrow keys to expand or collapse a template category and the Up and Down Arrows to 
move through the categories and template options. 

If you press the AppKey while the template is selected, for example the Blue Wave template, you can 
choose to use that template as the default for that Section. This will not affect existing pages but any 
page created from this point on will use the chosen template. 

Press F6 to move focus to the Templates Pane, press Ctrl + Spacebar then C to close the Templates Pane. 
While the Templates Pane is open pressing Ctrl + Page Up or Down will move you through the last 
searched for items if you’ve searched for anything during this session of OneNote. 

One of the caveats to using templates is that they often obscure some of the writing area. Keep this in 
mind when using a template for a Section. Although attractive, readability might be compromised if you 
can’t see where the stationary images are on the page or sub-page. 
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Figure 34 Sea Turtle template obscuring text. 

The preceding example is of the Sea Turtle template. You might not be able to see it clearly but the first 
insertion point for text is just under the date and time for the Page. Only someone using a screen reader 
or Text-to-Speech would be able to read this clearly. 

There are templates available on the Microsoft web site that includes various types of sheet music. If 
you are using a tablet computer with digital ink, you can create musical scores in OneNote. 

 

Figure 35 Description: Sheet Music template for treble clef. 

You can create custom stationary by setting it up on a page and choosing the “Save current page as 
stationary” option at the bottom of the New Page Task Pane [Ctrl + F, then N for New]. You will be 
prompted for a name for your stationary. Your custom stationary will be added in a section called “My 
Stationary” in the list of stationary choices. You must go through the File > New > “insert the name of 
your stationary here” in order to have it repeat across subsequent pages. Just pressing Ctrl + N on the 
page you used to create the stationary won’t work; you need to choose it as stationary in order to use it. 
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Note Taking Without Audio Recording 
For those of us using adaptive technology, we must remember that OneNote is designed to behave like 
a digital notebook. This means that we can write anywhere on a page at any time. There are note 
containers which help structure information, but we need to keep track of where we place note 
containers and information. If you are someone who can’t work with chaos on a page, then some of the 
tips for those of us using adaptive technology will be helpful. If you are someone who thrives on the 
freedom to doodle, scribble and put information anywhere you want, OneNote is a great tool and 
liberates you from traditional paper. 

For those of us using OneNote 2007 with a keyboard, the most important thing to remember is to press 
the Home key before moving to another note container.  

Within a note container, you can have text that is bold, italicized, underlined, a different font size, style 
and colour, bulleted or numbered lists, links to web pages or associated documents and Tags to denote 
tasks or importance of information. You can’t have an image in a note container. Image containers can 
be placed over or under note containers. Typically you will want to move out of a note container to 
insert an image. 

Note containers are as wide as the text they contain. If you have a small amount of text in one note 
container, that is the size used for all subsequent note containers on a page unless you resize them so 
that they extend horizontally across the page. 

In OneNote 2007 there is no ability to “clear formatting” once it is applied.  

Outline Structure 
Within a note container, you can mimic an outline structure. As mentioned, there are no heading levels 
in OneNote 2007. OneNote 2007 interprets the first line of information as the first level “heading” in an 
outline structure. By indenting information or out-denting information, you identify hierarchy in the 
document.  

For example, this line would be level one in an outline. 

 This indented line would be level two. 

  This increased indent would be level 3. I’ve pressed the Tab key three times. 

 

Figure 36 Indented levels collapsed after level 2 on an OneNote Page. 
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I used the “Goldfish” template for this image and a few others in this book in case you’re wondering. 

You can hide levels in an outline by pressing: 

• Alt + Shift + 2 to collapse everything below level 2. A graphic image of a plus sign is shown 
beside the collapsed level. At this point in time, screen readers are not able to determine a 
collapsed outline in OneNote. 

• Alt + Shift + 3 to collapse everything below level 3. 

• Alt + Shift + 4 to collapse everything below level 4. 

• Alt + Shift + 5 to collapse everything below level 5. 

• Alt + Shift + 6 to collapse everything below level 6. 

• Alt + Shift + 7 to collapse everything below level 7. 

• Alt + Shift + 8 to collapse everything below level 8. 

• Alt + Shift + 9 to collapse everything below level 9. 

• Alt + Shift + the number 0 to show all levels. 

You can have body text under a heading. You can identify this for OneNote by pressing Ctrl + Shift + the 
number 0 with your cursor anywhere in the paragraph that is body text. You can hide body text by 
pressing Alt + Shift + the Dash and show it again by pressing Alt + Shift + the Equal sign. When body text 
is hidden, there is a graphic plus sign beside the level containing the body text. 

Pressing the Tab key will increase the indent by one level and pressing Shift + Tab will decrease the 
indent by one level. 

If you are using the mouse, as you move the mouse to the left of each level, you will see the graphic plus 
sign. Right click on it and choose the option you want, to show or hide levels or to show or hide body 
text. 
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Tables in OneNote 
When you type a short phrase, this is seen by OneNote as “column” one if you then press the Tab key to 
the next Tab stop and type in another short phrase. This becomes column two.  

 

Figure 37 Table in OneNote. 

In OneNote 2007 the Table tools are found under the Table menu item. Press Alt + B to open the Table 
menu. The first item is Insert Table which, when activated will open the Table dialog to let you define 
the number of columns and rows. 

 

Figure 38 Table menu in OneNote 2007. 

The tools you have available will depend on whether you are in a table or not. 

You can also create a table using the Tab and Enter keys. 
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Let’s work through an example using the keyboard. Type the words Column One and press the Tab key. 
One Note now views this text as part of tabular information. Type the words Column Two at the Tab 
stop. Press the Enter key. Your cursor is directly under the C in the words column two. Press the 
Backspace key and you move back one Tab stop. Your cursor is now directly under the C in the words 
column one. Type some text. It doesn’t matter how long the text is. When you press the Tab key again 
to move back visually under column two, the text will wrap in column one. Type some text in column 
two and repeat this process until you have the information you want in tabular format. To jog out of 
tabular format, simply type a long line and don’t press the Tab key to identify a column. 

Unfortunately in OneNote 2007 I can’t find a way to resize columns using the keyboard. This is a mouse 
dependent activity. 

The keyboard commands for working with tables in OneNote are: 

• Press Tab to add another column to the table. 

• Press Enter once at the end of a row to add another row to the table. 

• Press Enter twice to exit the table. 

• Press Ctrl + Enter to add another row to the table when you are at the end of a row.  

• Press Alt + Enter  to create another paragraph in the same cell  

• Press Ctrl + Alt + R to create a column to the right of the current column.  

• Press Ctrl + Alt + E to create a column to the left of the current column.  

• Press Enter when the cursor is at the beginning of any row to create a row above the current 
one. 

• Press Delete twice when the cursor is at the beginning of a row to delete that row. 

Pressing Tab or Shift + Tab will take you to the next or previous cells as they do in Word. Keep in mind 
that Tab at some pint will also add columns or rows. If you are using a screen reader, listen to the 
information given to you. Tables in OneNote d not currently have the ability to designate column or row 
titles. 

In OneNote 2007 You can also insert a table from the menu bar.  Press Alt + B to open the Table menu 
bar item and then choose to Insert a table. This will produce the most accessible table for OneNote at 
the current time. 
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Figure 39 Table menu bar open. 

When you choose to insert a table a dialog opens where you can choose the number of rows and 
columns. 

 

Figure 40 Insert Table dialog. 

Figure 41 Insert Table dialog. 

Bullets and Lists 
You can format information in note containers as bullets or numbered lists in OneNote.  

Press Alt + the letter O, L to open the List Pane in OneNote 2007. You will need to Tab to the bottom of 
the Pane and choose either Bullets or Numbers. When you do this, you will be able to use the selection 
of bulleted or numbered formats. 

When you choose Bullets or Numbers in the List Pane with formatting options such as round bullets, 
diamonds, four diamonds in a square, hollow circle and so forth for bullets; and numbers, letters, legal 
and so forth for numbers. If you are using a screen reader, you navigate these using the down arrow. 
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You unlike a typical grid of choices, you can’t navigate left and right, you go down one column of options 
and then the next. OneNote does remember the last formatting style you used. 

 

Figure 42 Bullet selection in OneNote 2007. 

Using a keyboard, here are the keyboard commands for formatting information as a list or outline. 
Remember that the text or items, including handwritten entries should be selected. 

• Press Ctrl + Shift + the letter O to format information as a numbered list. 

• Press Ctrl + Shift + L to format information as a bulleted list. This will use the last chosen bullet 
style. 

• Press Tab to indent the list item by one level. 

• Press shift + Tab to out-dent the list item by one level. 

You can use the keyboard commands Ctrl + Shift + L and Ctrl + Shift + the letter O respectively. 

Two other keyboard commands that work in OneNote are Ctrl + Period which removes a bullet from 
content and ctrl + Slash which removes a numbered list from content. Neither of these keyboard 
commands remove the indentation associated with a list structure so once again you will need to press 
Shift + Tab at the beginning of the line  to move the content back to the margin. 
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Formatting Information 
In a note container you can format text for emphasis and decoration.  

Here are some other formatting keystrokes. Remember to format text, you need to select the text to be 
formatted before using the keyboard command. This prevents the overlapping of formatting and the 
potential for a visual mess in your document. 

In OneNote press Ctrl + D to open the Formatting Pane. If you are using a screen reader, you can use 
standard navigation keystrokes. Whatever font you are on in the list, is reflected visually on the selected 
text. Pressing Ctrl + F1 will close this Pane when you’re finished. 

The following keyboard commands can be used for selected content: 

• Press ctrl + Hyphen to Strikethrough text. This is a toggle. 

• Press Ctrl + the Equal Sign to make the text Subscript. This is a toggle. 

• Press Ctrl + Shift + the Equal Sign to make the text Superscript. This is a toggle. 

• Press Ctrl + L to left align content. 

• Press Ctrl + R to right align contents. 

• Press Ctrl + E to centre align content.  

• Press Ctrl + Shift + N to return formatting to the Normal paragraph style. Note that this still does 
not remove the indentation from content that has been structured as a list. 

• Press Ctrl + Shift + > to increase the font size. 

• Press Ctrl + Shift +< to decrease the font size. 

• Ctrl + Shift + R shows or hides rule lines on the current page. 
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Spell Check and AutoCorrect 
OneNote has spell check and AutoCorrect tools. The AutoCorrect dictionary is connected to Microsoft 
Office 2003 if you have it installed on your computer. This means you don’t have to re-enter information 
into the AutoCorrect dialog. 

 

Figure 43 Spell check Pane in OneNote. 

The spell check is done through a pane.  To activate the spell check from the keyboard, press F7. A Pane 
opens and your focus is in an edit box with the first misspelled word. There are no keyboard commands 
for quickly ignoring or changing the spelling, you have to tab to the button you want. The visual layout of 
the Spell Check Pane is the misspelled word under which is the Ignore button and the Add to Dictionary 
button followed by the list of suggested spellings under which is the Change button and the Start Spell 
Check button if you have left the Spell check Pane open. 

In the spell check Pane, there are links to set both spelling and Autocorrect options. These links are 
located at the bottom of the Spell Check Pane. 

You can use the AutoCorrect tool in OneNote. As you are reviewing and proofreading your content, you 
can press the AppKey or the Right Mouse button to get a context menu with spelling options. This 
context menu is similar to the one you finding other Microsoft Office applications. 
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Tagging Information 
OneNote includes some default Tags so that you can identify information for tasks or attention. You can 
also create some customized Tags for information. The Tags are described below with their 
corresponding keystrokes.  

The To Do Tag is a small check box that is empty the first time you press Ctrl + the number 1. If you press 
Ctrl + 1 again, you will check this check box indicating you’ve done this task, and pressing Ctrl + 1 a third 
time will deselect the To Do icon. 

To give information a high importance, press Ctrl + 2. This icon is a yellow star. Important items have a 
small yellow star beside them. This is a toggle and pressing this keystroke again will delete the icon.  

If there is something you need to ask about or is an important exam question, use Ctrl + 3 to put the 
question mark icon next to information. The icon for this is a small question mark. This is a toggle and 
pressing this keystroke again will delete the icon. 

Press Ctrl + 4 to mark something you need to remember. This will highlight the paragraph in yellow 
highlighter. This is a toggle and pressing this keystroke again will delete the highlight. 

Press Ctrl + 5 to mark something as a definition.  This will highlight the paragraph in a lime green colour. 
This is a toggle and pressing this keystroke again will delete the highlight. 

Ctrl + 6 marks something to be highlighted but not by using colour. This icon is what looks like a pencil 
on an angle. This is a toggle and pressing this keystroke again will delete the highlight. 

Ctrl + 7 marks a contact. It is represented by an icon similar to the contact icon used in Outlook. This is a 
toggle and pressing this keystroke again will delete the highlight. 

Ctrl + 8 marks an address and is represented by the icon used for your web site home page. This is a 
toggle and pressing this keystroke again will delete the highlight. 

Ctrl + 9 marks a phone number and is represented by a phone headset. This is a toggle and pressing this 
keystroke again will delete the highlight. 

Ctrl + number 0 removes all Tags from text. 

There are other tags you can use for identifying things such as “movie to see,” “Book to read,” “Call 
back,” or “Send in e-mail.” 

You can customize Tags by choosing that option. The Customize Tag dialog is accessible if you are using a 
screen reader however the Modify dialog for a Tag is not accessible by some screen readers. The screen 
reader will simply say “button, button, button” as you Tab around that dialog. 

The keyboard command listed above will work in both versions of OneNote. 
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In OneNote 2007 to show the list of available Tags press Alt + letter I, G for Insert, Tag which opens a 
sub-menu. 

 

Figure 44 List of available Tags in OneNote 2007. 

As stated previously you can use the list of keyboard commands such as Ctrl + 1, Ctrl + 2 and so forth to 
apply specific Tags to content. 

Listing Tags 
If you are using a screen reader or just want a summary of the Tags in a Section you can get a list of 
Tags. 

In OneNote 2007 press Alt + V, A for View, All Tags. The Tags List Pane opens to the right of your current 
OneNote page or sub-page. 
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Figure 45 Tags List Pane in OneNote 2007. 

If you lose focus from the Pane press F6 to move back to it and Shift + F6 to move back to your OneNote 
page or sub-page. Use the Tab key to move to the list of found Tags and then use the Up or Down 
Arrows to move among the Tags. Press Enter on the Tag you want and you will be taken to that Tag in 
the Section and the text will be highlighted. If you are using a screen reader you may have to press 
Shift + F6 to move back to the page or sub-page in order to see the found Tag. 

If you press Enter on one of the found Tags you are taken to that point in the Section and the text 
associated with the Tag is highlighted. 

Press F6 to move focus to the tags List Pane or Shift + F6 to move focus back to your OneNote page or 
sub-page. 
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Adding Content to a Page or Sub-Page 

 

 

 

This chatter explores how to add images, PDF documents; web based information and scanned 
information into an OneNote Section, Page or Sub-page. 

Linking and Associating Information 
In OneNote, you can include content from several sources in a note container.   You can select text and 
copy then paste it into a note container. You can also copy then paste links to files in a note container.  

To copy information from another application, select the information to be copied or moved and press 
Ctrl + C for Copy or Ctrl + X for Cut, switch to OneNote using Alt + Tab and ensure that your cursor is in 
the right location, then press Ctrl + V to paste it into position. You can copy or move small or large 
amounts of information. The information will either be set in a new note container, or if you are already 
in a note container, it will be added.  

In OneNote there is no paste special to let you include formatting from another application. If you select 
a heading level, this will be translated by OneNote into bolded text but have no hierarchy in the content. 
There is also no equivalent to the Styles Pane or Apply Styles Pane to view formatting. 

Adding Files or Documents to OneNote 
You can include files of any type on a page or sub-page. Go to the location of the file in My Documents 
or on another form of media such as a pen drive, flash card or CD and select the file or files you want 
associated with your section content. For students, this might be an instructors PowerPoint presentation 
or a video or audio file for the lesson. For those of you in business meetings, this might include an Excel 
workbook or PDF document. 

Use the keyboard command Ctrl + C to copy the file to the clipboard, then switch to OneNote and make 
sure your cursor is where you want it to be; then press Ctrl + V. The name of the file appears between a 
< and > sign, for example <filename.pdf>. You can move your cursor anywhere in this filename and press 
Enter to launch the file. A copy of the file is also brought into the folder containing the section in 
OneNote Notebooks. This is why it is important to organize your notes in folders as well as sections. If 
you don’t organize your sections into folders, you will have a huge chaotic pile of files at the end of a 
few months. You will then have to sort through all of them and move them into new folders you create 
as you try to better organize your notes and information. Everything will now be contained in OneNote 
Notebooks. 
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You can insert files onto a page or sub-page by pressing Alt + letter I, F to Insert, Attach File. This opens a 
dialog where you can choose the file you want. 

Contextual Links 
In OneNote you can use contextual links. This means that you can select text, press Ctrl + K and either 
link to another Section, Page or Sub-Section or link to a web address.  

In OneNote 2007 select the text you want to be the link and press Ctrl + K. You are in an edit box where 
you can either enter the information for a section, page or sub-page or type or copy/paste a web 
address. 

 

Figure 46 Link dialog in OneNote 2007. 

Once you are returned to the document the link will be active. 

 

Figure 47 Contextual link in OneNote 2007. 

When you Tab to the OK button and press Enter or just press Enter after identifying the item to link to, 
you can then move into the linked text and press the AppKey to see the context menu for that link. 
Notice that there is not an “Open Link” option. 

If you are using the JAWS screen reader you will hear both the text for the link and then the long web 
address or location. 

To open a link make sure your cursor is somewhere in the text or the web address and press Enter. 
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Figure 48 Context menu for link in OneNote 2007. 

Jaws currently does not identify links on pages or sub-pages. In the following image, the link has 
adjusted in colour to the colour I choose as my regular font , size and colour. This is an issue with JAWS 
not recognizing the underlying link structure in OneNote. 

 

Figure 49 Link on a page or sub-page. 

Internet Explorer Integration 
There are two other ways to put web based content into OneNote. We’ve looked at making contextual 
links in an OneNote document. Another method is to press Alt + D to go to the Address Bar of either 
Internet Explorer or Firefox and press Ctrl + c to copy it, switch to OneNote and press Ctrl + V to paste it 
into a note container. 

A web address copied to a page or sub-page appears as http://www.karlencommunications.com.  

In OneNote 2007 you can provide context or “text to display” for a long web address by selecting the 
long web address and pressing Ctrl + K which opens the Link dialog. Press Tab to move to the “Text to 
display” edit area and type in the text you want displayed instead of the long web address. Once you are 
finished, either press Enter or Tab to and activate the OK button to confirm your changes. 

 

http://www.karlencommunications.com/
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Figure 50 Add text for a link in OneNote 2007. 

The other method to include content into your OneNote notes is to “Send to OneNote” which is 
available in Internet Explorer. If you are using Mozilla Firefox you can only “Print to OneNote.” The 
complete integration is available if you are using Internet Explorer.  

In Internet Explorer press Alt + T, N for Tools, Send to OneNote. 

 

Figure 51 Send to OneNote 2007 in Internet Explorer 8. 

Once you choose to send a web page to OneNote using OneNote 2007 and Internet Explorer 8 a new 
OneNote Page will open. Usually it opens in the last Section you were working in but you will need to 
review this once the content has been sent to OneNote. 

Some of the formatting of the web page will be lost however the text of the page is readable if you are 
using a screen reader. If you are not using a screen reader the content is still fairly easy to navigate. 
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Figure 52 Content sent to OneNote 2007 from a web page. 

Once you return to OneNote you’ll find the full web address at the bottom of the copied content. It will 
read as follows: “Inserted from <http://www.karlencommunications.com/Blog/> which is the web 
address for the Karlen Communications Blog article used in this example. 

 

Figure 53 Send to OneNote 2007 options. 

http://www.karlencommunications.com/Blog/
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Print to OneNote 
From OneNote you have the ability to use the Print dialog, Ctrl + P, to “Print to OneNote” which inserts a 
page or document into an OneNote container as a scanned image of the page or document. This content 
can then be made searchable. Making the text searchable is the equivalent to performing OCR or Optical 
Character Recognition on an image of text. You wouldn’t want to do this for documents that are already 
accessible. You would use this tool for documents coming from applications other than Microsoft Office. 

Open a document from any application. Press Ctrl + P and choose “Send to OneNote 2007” as the 
printer. Tab to and activate the OK button. 

 

Figure 54 Send to OneNote chosen as printer. 

While the document or content is being printed or sent to OneNote you will have a progress dialog 
updating the conversion. 

 

Figure 55 Progress of content being printed to OneNote 2007. 

Some screen readers have problems finding this type of content. This is one of those areas that needs 
more support from adaptive technology. If you use the technique of putting focus on a note container 
and using Tab or Shift + Tab to move through containers, you will come across something that says 
“Machine generated text” which is a page of scanned text or an image. Because you know the content 
of the page you can determine whether this is the scanned page you want to make searchable. You can 
verify this by pressing the AppKey to see if “Make Text Searchable” is an option. 
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If you can locate and select the container that the document is in, press the AppKey and choose “Make 
Searchable.” A sub-menu opens with your language choices. Press Enter on the one you want…of course 
it will depend on the content you just printed to OneNote. This is not a translation tool but a text 
recognition tool. 

If you don’t see these in Office 2007 you may need to install the ability to perform OCR on scanned 
documents. Office 2007 includes a “light” version of the Nuance Omni Page Pro OCR software called the 
Microsoft Office Document Imaging tool. Once installed this lets you scan documents into the Microsoft 
Document Imaging tool, perform OCR on them and then send the now readable content to Word. This is 
the tool also used by OneNote to make text searchable in scanned or printed to OneNote content. 
[There is a free document on the Karlen Communications web site, Office 2007 resource page on using 
the Document Imaging tool in Office 2007.] 

 

Figure 56 Make Searchable options from context menu on printed to OneNote 2007 content. 

Once you’ve made the content searchable, select the container again if it loses focus and press the 
AppKey again for the context menu. Choose to either copy the current page or the entire document to 
the windows Clipboard. 

 

Figure 57 Copy entire content document option selected from context menu. 

You can now move to another page or sub-page and paste the content using Ctrl + V. You can also copy 
this content into a Word document. 
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I mention the need to put the content you make searchable in another page or sub-page for people 
using screen readers as it will be easier for the screen readers to locate and read this content. If you 
have a learning, cognitive or visual disability or aren’t using a screen reader you can leave the content in 
its original container. 

There is an option under the Office Button to send the content directly to Word without copying and 
pasting. It can be found under Office Button, Send To. 

Adding Scanned Documents to a Page or Sub-Page 
If you have a scanner connected to your computer you can scan a page or document right into OneNote 
then make the text searchable as we did in the last topic and use it in other applications; or put it into a 
more readable container in OneNote.  

I mention the need to put the content you make searchable in another page or sub-page for people 
using screen readers as it will be easier for the screen readers to locate and read this content. If you 
have a learning, cognitive or visual disability or aren’t using a screen reader you can leave the content in 
its original container. 

To scan directly into OneNote, create a new page or sub-page or place your cursor where you want the 
content to be placed in an existing page or sub-page. Press Alt + Letter I, P for Insert, Picture. From the 
sub-menu choose from scanner or camera. I didn’t have a scanner available when I did this section. 
Once you tell OneNote to insert information from a scanner you might be prompted to choose the 
scanner and then insert the page.  

 

Figure 58 Insert from Scanner or Camera in OneNote 2007. 

Inserting Files and Printouts to a OneNote Section 
If I already have files or documents such as PDF, PowerPoint, Excel or Word documents I can add them 
to my OneNote Pages or Sub-Pages.  

You can have both the document and the printout on the same page.  I recommend this approach to 
adding this type of content to OneNote so that you have access to the original document if you need it. 

Having a searchable version of the document that can be easily accessed without actually opening the 
document is handy at times, while at other times you might need to check or review the original 
document. By putting both on the same page it is easier to locate and use both. 
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The staff at Seneca College in Ontario Canada showed me this great use of the insert as printout tool for 
students with learning, cognitive or visual disabilities. The slides from the PowerPoint document can be 
on one side of the page and the notes you take can be right beside them. 

At the same time if I need to review the PowerPoint document in its native form, I can move to the top 
of the page or sub-page and access the attached file. It provides the best of both worlds. 

 

Figure 59 A slide on a OneNote page with the class notes beside it. 

You will need to resize both the image of each slide and the note container if you want them both to fit 
on the screen side by side. 

If you are using a screen reader you will need to make the text searchable in the slides. This may not be 
a practical use for those of you using screen readers, however try it and see if you can use this 
technique. The problem for those of us using screen readers is that we currently don’t have information 
on our location on a line or anywhere else in an OneNote page or sub-page. Once we have access to this 
level of information in OneNote, we will be able to use this technique more effectively. 

In OneNote 2007 press Alt + letter I for Insert and then letter O for Files and Printouts. 
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Figure 60 Insert File and Print out from Insert menu of OneNote 2007. 

The “Choose Document to Insert” dialog opens and you can locate the document you want to add to the 
OneNote Section. 

 

Figure 61 Insert file or printout dialog. 

When a file or document is inserted into an OneNote 2007 page or sub-page and the AppKey is pressed 
for the context menu, the name of the document and the date it was last modified is displayed. This 
information is not available to screen readers. 
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Figure 62 Document inserted into an OneNote 2007 page. 

You can open the document using this context menu or you can add it to the current page or sub-page 
by choosing to “Insert as Printout.” This will put the document on the page or sub-page as an image of 
the document which will then need to be made searchable. However this would let you see the contents 
of the document and still have access to the actual document linked to on the page or sub-page. 

Keep in mind that if you move the notebook or the document you are linked to, the link will be broken. 
This might be another good reason to include a searchable printout of the document on the same page 
as the linked to document. 

If you are using the keyboard and/or a screen reader you can locate the icon representing the attached 
document, press the AppKey for the context menu and choose Open from the context menu to open the 
document in its native application, in this example Word. 

If you are using Windows 7 you might get a warning about the security of the document even if it was 
attached from your computer. 

Notice that in the context menu you can also open the document as a printout. Of course this would 
mean that you would have to perform OCR on it to read it using adaptive technology.  

As shown in the following image you could have a direct link to the document as well as a quick way to 
review its contents on the same OneNote page or Sub-Page. Each page of the document is in its own 
note container. In performing this task, unlike scanning into OneNote, I didn’t have to resize the note 
container to accommodate the width of the page. 



59 
 

 

Figure 63 Attached document and document as printout on the same OneNote Page. 

Adding Images to Pages and Sub Pages 
There are two ways to use images on a page or sub-page. You can link to an image, or you can insert the 
image into a container.  

Copying Images into OneNote 
The first method of adding an image to an OneNote 2007 page or sub-page is to locate the picture, 
select it, press Ctrl + C to copy it, switch to OneNote, and paste it at the cursor point. 

There is no tool in OneNote 2007 to add Alt Text to images on pages or sub-pages. Images also have to 
be sized manually. There is no “size” option in the context menu for an image. 

Versions of screen readers that worked with Office 2007 often didn’t report images but tended to ignore 
them and be silent. Some of the current screen readers might read images as “picture, 4 inches wide by 
3 inches high.” Without the ability to add Alt Text the author should write a “caption” under images. 
There is also no caption tool in OneNote. For instructors providing information for students in OneNote 
2007 it is important to identify images or diagrams and provide a brief description of them. 
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Inserting Images into OneNote 
The second method of adding images to OneNote is to use the Insert menu in OneNote 2007. 

Press Alt + letter I for Insert and then P for Picture.  

 

Figure 64 Insert Picture from file in OneNote 2007. 

This will open the Pictures folder in Vista or the My Pictures folder in Windows 7. Locate the image you 
want included on the page or sub-page and either press enter or Alt + letter O to “open” it on the 
current page or sub-page at your cursor point. 

Versions of screen readers that worked with Office 2007 often didn’t report images but tended to ignore 
them and be silent. Some of the current screen readers might read images as “picture, 4 inches wide by 
3 inches high.” Without the ability to add Alt Text the author should write a “caption” under images. 
There is also no caption tool in OneNote. For instructors providing information for students in OneNote 
2007 it is important to identify images or diagrams and provide a brief description of them. 

You may need to resize the image. Sometimes you have access to the resize tools and sometimes you 
don’t. It depends on where you insert the picture. If it is inserted into an existing container it tends to 
resize itself to fit the container. If you are out of a container it will be inserted at its normal size. 

Adding Video or Audio to a OneNote Page or Sub-Page 
You can add audio or video directly into OneNote 2007. You will need an external microphone or 
connection directly into the room’s sound system for audio and a connection to a video camera for 
adding video based content directly into OneNote. 

However you can add existing audio or video files to your OneNote pages or sub-pages. 

In OneNote 2007 press Alt + letter I, F to insert a File or document. There is no distinction between a 
text based document or an audio or video file you have on your computer or storage device. Follow the 
same steps as for inserting documents but locate and select the audio or video file you want from the 
Music or Video folder in Vista or the My Music or My Videos folder in Windows 7. 
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Figure 65 Context menu for audio file inserted into OneNote. 

Notice that the icon in the previous image for an audio file is the same icon used in Windows Explorer to 
identify audio files. It will be the same with video files…the icon will reflect the type of content. 

By using the context menu you can play the file from OneNote. 

Note Taking With Audio and Annotation 
One of the nifty features of OneNote is that you can record meetings and lectures. This is not the Voice 
Recorder tool that you can access from the Accessories menu; it is a tool that will create a Windows 
Media file that is linked to your note containers in OneNote. The files are stored with your notebook. 
You can also play the audio file through Windows Media Player when you aren’t in OneNote. 

The recording tool uses the SpeakAnywhere technology available on tablet operating systems. You can 
use it on a desktop, but the effects aren’t as spectacular since your desktop computer isn’t terribly 
portable.  If you are trying to record conference sessions or lectures, you need to sit near the 
speaker/lecturer and you might need to use something like the Sony ECM F03 boundary effects 
microphone. This credit card size microphone has a boost switch which may help in larger rooms. 

In OneNote 2007 there are no direct keyboard commands for using the recording tool. It is 
recommended that you anchor the recording toolbar in the toolbar section of your application Window. 
If you don’t it will float over your notes and get in your way. 

http://www.sonystyle.com/is-bin/INTERSHOP.enfinity/eCS/Store/en/-/USD/SY_DisplayProductInformation-Start;sid=QGZdnzg8Ee1dznk3rZpXlHctoZe2UPgTvIE=?ProductSKU=ECMF01&Dept=pa&CategoryName=pa_PADepartmentAccessories_Microphones_BusinessMics
http://www.sonystyle.com/is-bin/INTERSHOP.enfinity/eCS/Store/en/-/USD/SY_DisplayProductInformation-Start;sid=QGZdnzg8Ee1dznk3rZpXlHctoZe2UPgTvIE=?ProductSKU=ECMF01&Dept=pa&CategoryName=pa_PADepartmentAccessories_Microphones_BusinessMics
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The keyboard commands for adding an audio or video recording to your page or sub-page are: 

• Alt + letter I, U for Audio Recording. 

• Alt + letter I, V for Video Recording. 

 

Figure 66 Insert menu from OneNote 2007 showing insert audio and insert video. 

When you launch the audio recording function for the first time you are asked if you want to make the 
audio searchable. This is a dialog that opens automatically when you first press Alt + letter I, U. 

 

Figure 67 Make audio searchable dialog. 

You can set this in the OneNote Options dialog if you miss this dialog or accidentally exit it without 
reading it. Press Alt + T, letter O to open the OneNote Options dialog and then choose Audio and Video. 
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Figure 68 Audio and Video settings in OneNote 2007. 

There is a check box to turn on audio search. 

Once you press Alt + letter I, U for Insert, Audio Recording, an icon for an audio or video recording is 
placed at the cursor point, the Recording toolbar is launched if it isn’t visible in the Toolbars and 
recording begins. The same process occurs when you press Alt + letter I, V for Insert, Video if a video 
camera is connected to the computer. Some items in the Recording toolbar might be different but the 
process is the same. 

You can access the Recording toolbar by pressing Alt then Ctrl + Tab to cycle through the toolbars until 
you find the Recording toolbar. Although an awkward process, the Recording toolbar is accessible. 

An icon will appear at the cursor point. To play the audio or video using your default playback 
application press the AppKey and choose Play. 

If you want to record and annotate a lecture or meeting in OneNote 2007 press Alt + V, V for View, 
Audio and Video toolbar. This shows the recording toolbar all the time, not just when you choose to 
insert and audio or video file. This toolbar floats over the main document area and should be docked 
with other toolbars for easy access. 

Move to the Audio and Video or Recording toolbar by pressing Alt, Ctrl + Tab to the Recording toolbar 
and then activate the record audio only button which is on the left of the toolbar. 

 

Figure 69 Recording toolbar in OneNote 2007. 
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The “Record audio only” button is a “split” button which means that if you press the Spacebar on the 
split button you will have the option of recording audio or audio and video [in this case]. By default you 
will be recording audio only. 

Along with the audio file icon, a notation on the current page at the current cursor location will let you 
know that the recording has started. As you add notes under this line of text, the notes become the 
annotation or connection to the recording at that specific point in the recording. For example if you type 
or write “this will be on the test” that will mark that point in the audio file where the instructor 
identifies what you will need to study. In reviewing your notes you can quickly go to a specific point in 
the audio file 

 

Figure 70 Audio file annotation in OneNote 2007. 

If you move the cursor down through the notes you will be able to see the time differences in the 
Recording toolbar. 

 

Figure 71 Progression of audio file as you move through text in OneNote 2007. 

You can also see the option to play the recording at the cursor point in the page or sub-page however 
this is not accessible if you are using a keyboard or screen reader and is only usable by mouse. 
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Figure 72 Icon for playing audio or video file next to specific line on page or sub-page. 

If you want to save the audio file to play on a device such as an MP3 player or the Victor Reader stream, 
select the icon for the entire recording, press the AppKey and choose Save As… which will let you save 
the file as a WMA or Windows Media Audio file. 

 

Figure 73 Save As...from the audio file in OneNote 2007. 

If you are not using a mouse, the only way to play the audio content at the point of annotation in 
OneNote 2007 is to move back to the Recording toolbar and activate the Play button. 

Audio files take up a lot of room. You will need a large hard drive if you are going to create an archive of 
audio files associated with notes.  

You can’t edit audio files unless you have an application that allows you to edit Windows Media files. 
Typically these are applications you purchase. 

As you play the audio file, if you have the setting to highlight the annotated content turned on, you will 
see the text highlighted as the audio file plays. 
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Figure 74 Annotated text highlighted on a OneNote page. 

If you want to listen to the entire audio file you can select it, press the AppKey and choose Play. 

You can save the audio file to play on an MP3 player or the Victor Reader Stream by selecting the audio 
file icon, pressing the AppKey and choosing Save As. The file will be saved as a WMA or Windows Media 
Audio file if it is an audio recording. 

 

Figure 75 Save As...option from the audio file context menu in OneNote. 
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Send to Word or Outlook 
You can share your OneNote content with other people who have OneNote or those who do not. One of 
the ways OneNote is being used in education is by note takers for students who are deaf. The notes are 
taken in OneNote and then sent to students using e-mail or through a shared notebook on a server. 

To send an OneNote page or sub-page to Word press Alt + F, D for Office Button, Send. 

 

Figure 76 Send options in OneNote 2007. 

When you send a page or sub-page to Word, the text is formatted the way it is on the page or sub-page. 
In this example the content sent to Word 2007 was from a scanned page and the text was made 
searchable then copied to another OneNote page.. 

 

Figure 77 OneNote 2007 page sent to Word 2007. 
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The text is not in a text box and is readable if you are using adaptive technology. You will have to add 
structural elements such as headings to the Word document. 

If you choose to send the OneNote page or sub-page to an e-mail recipient it will be an attachment in 
both OneNote and HTML format. This lets someone who may not have OneNote on their computer 
open and read the OneNote content. 

 

Figure 78 OneNote 2007 page sent to e-mail recipient as attachment. 

If you choose to send the OneNote page or sub-page as a PDF document, the PDF document attached to 
the e-mail will be tagged. You will need to install the Save as PDF or XPS add-in to have this option 
available. 

 

Figure 79 Tagged PDF OneNote page with Tags. 

The tagged PDF has no structure other than the <P> Tag or paragraph Tag. If there are headings and lists 
you will need to repair the PDF to more accurately reflect the content structure. You can also save a 
page or sub-page as a tagged PDF document by choosing PDF as the format in the Save As…dialog. 

You can also send the contents of a OneNote page or sub-page to a Blog. This may require permission 
for password and login information to be “visible” to web based “entities” and you will have a dialog 
advising you that using this tool requires the use of secure and non-secure content. Review this option 
carefully before blogging from OneNote. 

The keyboard commands for the Send File/Backstage area are: 

• Alt + F, E to send as an e-mail page. 
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• Alt + F, A to send as an e-mail attachment. 

• Alt + F, P to send as tagged PDF. 

• Alt + F, W to send to Word. 

• Alt + F, B to send to Blog. 

Sharing Notebooks and Working Collaboratively 
One of the strengths of OneNote is that anyone working in a group can work with other group members 
on a OneNote page. If everyone in the group agrees to use the keyboard rather than digital ink, 
someone using a screen reader or other adaptive technology can participate in the work. When the 
sharing session has ended everyone will have access to the work done by the group. 

To start a shared session in OneNote 2007 press Alt + S, L and choose Start Sharing Current Section 
which is the top item on the sub-menu. The Share menu is also where you go to create a shared 
notebook. 

 

Figure 80 Start Live Sharing session in OneNote 2007. 

The Sharing Pane opens to the right of the current page or sub-page and you can start the session or 
create some passwords for participants. 

 

Figure 81 Sharing Pane before the session has been started. 
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If you activate the Start Live Sharing button the information in the Pane changes and you can invite 
members, locate the IP address for the shared session and see who else has been invited and is 
currently sharing the section. 

The entire section will be shared and you are warned of this before you share the section. 

 

Figure 82 Notification that the entire section will be shared in OneNote 2007. 

If you choose to invite members, an e-mail will open in Outlook and the information for the shared 
session will be in the body of the message. You are in the “To” edit area and can type in the people you 
want to share the section with. 

 

Figure 83 Sharing Pane once the session has been created. 

This is real time collaboration on the section. As people type content into the page or sub-page you will 
see it on your screen. 
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Figure 84 Part of the e-mail message sent to people you invite to share a OneNote 2007 section. 

You can synchronize  shared notebooks using the keyboard with the following keyboard commands: 

• F9 to sync changes in all shared notebooks. 

• Shift + F9 to sync changes in the current shared notebook. 

OneNote Mobile 
If you have a Windows Mobile phone you can put OneNote 2007 on the phone and use it to take notes. 
You have access to the word prediction tool which makes using it a bit easier….less typing. 

There are limitations to the types of content you can add, however it is a useful tool for taking notes and 
then synchronizing them to your desktop version of OneNote 2007. 
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Figure 85 OneNote Mobile settings in OneNote 2007 Options dialog. 

OneNote Mobile is no longer available as part of the Office suite in 2010. You can find more information 
on OneNote Mobile at the Windows Phone web site4. Also note that Windows Mobile 7 is not usable at 
this point in time with third party adaptive technology and does not have any on-board adaptive 
technology such as Narrator or Magnifier.  

                                                           
4 Windows Phone, OneNote Mobile web site: http://www.microsoft.com/windowsmobile/en-hk/help/v6-5/OneNote-
Mobile-touch.aspx  

http://www.microsoft.com/windowsmobile/en-hk/help/v6-5/OneNote-Mobile-touch.aspx
http://www.microsoft.com/windowsmobile/en-hk/help/v6-5/OneNote-Mobile-touch.aspx
http://www.microsoft.com/windowsmobile/en-hk/help/v6-5/OneNote-Mobile-touch.aspx


73 
 

Outlook Integration 

 

 

 

OneNote 2007 has integration with Microsoft Outlook. OneNote was designed to integrate with other 
Office applications and this is where you will find seamless workflow opportunities.  

In OneNote 2007 the settings for Outlook Integration are found by pressing Alt + F, letter I for Office 
Button, OneNote Options. 

 

Figure 86 Outlook Integration category for OneNote 2007 settings. 

In OneNote 2007 to access Outlook Tasks or Meeting Details press: 

• Alt + letter I, K for Outlook Tasks which opens a sub-menu. 

• Alt + letter I M for Outlook Meeting Details which opens a dialog to choose a date and 
participants for the meeting. 
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Figure 87 Insert Outlook Tasks from the Insert menu in Outlook 2007. 

The following images show OneNote keyboard commands for Outlook tasks visualized.  

 

Figure 88 Create Today task from selected note. 

 

Figure 89 Create Outlook items from OneNote. 

Once you create an appointment, Outlook opens and you can fill in the details. There is no visible linking 
between Outlook and OneNote so you will need to tag the text related to the point at which you 
decided to create the Outlook appointment. 
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Figure 90 Outlook appointment created from OneNote. 

While in Outlook appointments [Ctrl + 2] you can create a OneNote note that will be linked to your 
appointment. The OneNote icon is on the far right of the Appointment Home Ribbon. 

 

Figure 91 Appointment Ribbon in Outlook 2007. 

When you create an OneNote note in Outlook, the “appointment” is opened in OneNote with all of the 
current information about the appointment. 

 

Figure 92 OneNote notes created in Outlook for appointment. 
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This information does not update automatically as you enter it in the Outlook appointment. Make sure 
you have all of the details related to the meeting in the Outlook appointment before creating the 
OneNote note. 

While in Outlook, switch to Appointments by pressing Ctrl + 2. Use Ctrl + N to create a new appointment 
and you have access to linking to an OneNote item from the “Appointment” Ribbon [Alt + H, letter O, N]. 

 

Figure 93 OneNote note from an Outlook appointment. 

There are more options for integration with Outlook in OneNote 2010. There is an OneNote 2010 from 
the Keyboard document on the Karlen Communications web site on the page for Office 2010.  
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Resources 

 

 

 

There are resources available for using OneNote with or without access to digital ink on a tablet 
computer.  

OneNote 2007 Microsoft resource page.5 

OneNote 2010 resource page from Microsoft.6 

Using the writing pad and touch screen on a tablet PC.7 

 

 

 

 

 

 

                                                           
5 OneNote 2007 resource page from Microsoft: http://office.microsoft.com/en-us/welcome-to-the-2007-microsoft-
office-system-FX101829962.aspx?CTT=6&origin=EC001023000  
6 OneNote 2010 resource page from Microsoft: http://www.microsoft.com/office/make-it-great/en-
ca/default.aspx?wt.srch=1  
7 Windows home page, Using the writing pad and touch screen on a tablet Pc: http://windows.microsoft.com/en-
US/windows7/Using-the-writing-pad-and-touch-keyboard-in-Tablet-PC-Input-Panel  

http://office.microsoft.com/en-us/welcome-to-the-2007-microsoft-office-system-FX101829962.aspx?CTT=6&origin=EC001023000
http://www.microsoft.com/office/make-it-great/en-ca/default.aspx?wt.srch=1
http://windows.microsoft.com/en-US/windows7/Using-the-writing-pad-and-touch-keyboard-in-Tablet-PC-Input-Panel
http://office.microsoft.com/en-us/welcome-to-the-2007-microsoft-office-system-FX101829962.aspx?CTT=6&origin=EC001023000
http://office.microsoft.com/en-us/welcome-to-the-2007-microsoft-office-system-FX101829962.aspx?CTT=6&origin=EC001023000
http://www.microsoft.com/office/make-it-great/en-ca/default.aspx?wt.srch=1
http://www.microsoft.com/office/make-it-great/en-ca/default.aspx?wt.srch=1
http://windows.microsoft.com/en-US/windows7/Using-the-writing-pad-and-touch-keyboard-in-Tablet-PC-Input-Panel
http://windows.microsoft.com/en-US/windows7/Using-the-writing-pad-and-touch-keyboard-in-Tablet-PC-Input-Panel
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